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Introduction

Hello, and welcome to DLaunch!  DLaunch was created to allow you to quickly select one of 
many PWAD files (Patch WAD customized levels) or the default DOOM.WAD, from any drive and 
path on your network, select the command line options you want, then start the game.  The whole
idea is to make the process as fast as possible, so DLaunch comes with its own private .INI file 
that it uses to store all of your default settings (if you wish).

DLaunch is designed to accomodate DOOM Version 1.6 Beta (see later section entitled "What 
Could Go Wrong?).

Whodunit?

The author, Allen Look, can be contacted via CompuServe address 75000,405 for technical 
support or suggestions on how to make the product better.  Any and all suggestions are welcome,
but please exclude physiological impossibilities.

Windows is a product of Microsoft Corporation.  DOOM is a product of Id Software.  Microsoft and
Id Software are not responsible for technical support of the DLaunch product.  If you have not 
done so, please consider registering your version of DOOM.  It's well worth it.



What does it require?

This product was developed in Visual Basic, and as such will require that you have 
VBRUN300.DLL in your \Windows\System directory (supplied on CompuServe or with Visual 
Basic 3.0 from Microsoft).  DOOM requires that you have at least 8MB of memory to run under 
Windows.  You require a sense of adventure to play it.

How do I get it to work?

The Files

Basically, all you need to do to install DLaunch is the following:

1.  Create a directory somewhere. (Calling it DLaunch would be cool).
2.  Copy your DLAUNCH.ZIP file to that directory and unzip it there.
3.  Acquire and copy the VBRUN300.DLL file into your \Windows\System directory.
4.  Create an icon that calls DLAUNCH.EXE (or better, a PIF with lots of memory).
5.  See the section later in this document entitled What Could Go Wrong? if you 
encounter problems.

Recommended PIF Settings

These are the setting I use for a PIF that calls DOOM:

Program Filename: DOOM.EXE
Window Title: DOOM
Optional Parameters: (none, it'll take 'em from DLaunch)
Startup Directory: C:\DOOM (or wherever your DOOM lives)
Video Memory: High Graphics
Memory Req.:

KB Required: -1 Desired: -1
EMS Required: 0 Limit: -1
XMS Required: 0 Limit: -1

Display Usage: Full Screen
Execution: Exclusive
Close Window On Exit: Yes
MultiTasking:

Back. Prio: 100
Fore. Prio: 100
Det. Idle Time: No

Uses High Memory: Yes
Monitor Ports: None
Reserve Keys: Alt+Enter

Alt+Space



What does it get me?

DLaunch basically allows you to choose a WAD file (DOOM.WAD is the default if none is 
selected), click on the options you wish (like monsters, or skill level), then press a button to 
launch your favorite version of DOOM.  You can also choose a saved game or a demo file to 
watch if you prefer.  Following is a list of the options available in DLaunch, and what each will do 
for you...

The Menu

The menu for DLaunch is very simple, basically consisting of 3 selections.

The File menu contains four options, one option called Skank, which is used to delete 
PWAD files that just don't make the cut, a second option to start the Episode Builder - 
(Episode...), a third option to start a game - (Launch DOOM), and lastly an option to leave
the program - (Exit).

The Options menu contains one selection which, when checked, will save all of your 
settings upon DLaunch's exiting, (except for the currently chosen WAD file).

The Help menu's Contents option will display a dialog box pointing you to this file.  The 
Cheat Codes and Parameters options each display helpful key commands or command 
line parameters to modify DOOM's actions. The About option displays an "About box" 
showing you the version of DLaunch, and where to send the money if you find the 
program of use!

File Selection

The File Name and selection box allows you to select a file (or files!) to use with DOOM.  
When used in conjunction with the other controls on the form, you can select any type of 
file on your system, including files on the network.  You may type the name of the file you 
wish in the File Name box, or you can select the file by using your mouse in the scrollable
list box.  Selecting multiple PWAD files will load all of them at once!



Drive, Directory, and File Type Selection

The Directory, Drive, and File Type windows are used to select the source drive and 
directory that contains your DOOM files, and the type of files you wish to display.  The 
File Type box will let you display WAD (DOOM level for playing), LMP (DOOM 
demonstrations), DSG (DOOM saved games), and ALL (*.*) files on your disk.

Game Options

Once you've chosen a file to play, the Game Options dialog gives you the ability to set up 
the game a little differently.  Each of the options in this groups corresponds to a command
line switch that you could, if you chose, type in at the C: prompt when you run DOOM.  

Commands are enabled or disabled as appropriate (meaning that if you choose to use 
Warp, the DevParm parameter is automatically turned on).  The AutoWarp feature, if 
turned on, will automatically warp to the correct level of any customized "PWAD" file you 
load!

Music/SFX is obvious.  DevParm is for you developers and warpers out there.  
Deathmatch is for you lucky individuals who have someone to play against and some 
way to get there, and the Alternate Rules option turns on the Deathmatch 2.0 rules 
available in DOOM Version 1.6 Beta.  Turning off monsters will, obviously turn off all the 
monsters, but then, what's the point?  The respawn option is used to make monsters 
reappear about 8 seconds after you kill them.  Ouch!  And the Fast option will make the 
monsters move at the same speed as the "Nightmare!" level.



Executables and Additional Options

DLaunch obviously needs to know what to execute when you want to kick that demon 
butt, and the Executable fields are where you specify this.  You can include the path and 
name of any Windows executable file, such as C:\DOOM\DOOM.EXE, or C:\DOOM\
DOOM.PIF.  If you want to point and shoot, press the command button next to the 
Executable boxes with the elipsis (...), and a File Selection dialog will be displayed.

If you wish to pass any command line parameters to DOOM that have not been included 
in the Game Options dialog area, you may type them in the Additional Parameters text 
box, and they will be passed to DOOM when you launch it.

Game Style

_______________________________________________________________________
____

_______________________________________________________________________
____

The best part of DOOM is that you can play multi-player!  Whether cooperative or 
DeathMatch, the competition is unrivaled by computer opponents...  There's nothing like 
going up against a buddy to kick a little co-worker, uh, I mean demon butt!

You can select a Standalone game if you just want to play solo, or you can choose one of
the methods of connection (Serial or IPX) to try multi-player.  The Serial connection 
allows you to enter Answer mode, or to dial your modem and connect to another player's 
computer via COM1, COM2, COM3, or COM4.  These choices are fairly straightforward.  
If you wish to use a Null Modem cable, select Serial Connection and leave the Dial box 
blank.



The IPX connection requires that you have an IPX compatible network, and that up to 4 
players connect at the same time using the same Port # (or Socket), and the same 
number of Nodes.  An example would be that 4 people connect across an IPX network 
using Port 0 (the default), with each player specifying 4 Nodes.  Specifying more than the
actual number of nodes will cause the game to hang during initialization while it waits for 
additional players to join the game.  The next group of people who wish to play can 
specify Port 1 and the games will run over the network simultaneously.  Make sure you 
check with your Network Administrator regarding the Port setting.

I would suggest looking at the documentation for the programs SerSetup.Exe and 
IPXSetup.Exe for more information on how they work.  (Run the README program 
supplied with DOOM for more information).

The Buttons

The buttons perform the following functions:

DOOM will launch the program specified in the DOOM, IPX, or Serial Executable text box
(depending on the Game Style you chose), and will add in the WAD, LMP, or DSG file 
you have selected, then pass the command line parameters you picked in the Game 
Options box (like -respawn, -skill #, etc.) or specified in the Additional Parameters box.

The Close button will close DLaunch and return to Program Manager.



The Defaults button will reset all fields with their default values, which are as follows:

Save Settings on Exit True
Sound False
SFX False
Music False
Respawn False
Monsters True
Warp False
Episode 1
Map 1
Game Style Standalone
Answer False
Net Nodes 2
Net Port 0
COM Port 1
File Type *.WAD
Skill 3
DeathMatch False
Developer's Mode False
DOOM Path C:\DOOM\DOOM.EXE
IPX Path C:\DOOM\IPXSETUP.EXE
Serial Path C:\DOOM\SERSETUP.EXE
Dial Text None
Drive C
Path \
Additional Parameters None

The Save Settings button will save your settings immediately in your DLaunch.INI file 
which should be located in your C:\Windows directory.  You can also select the Save 
Settings on Exit option under the Options menu to have your settings saved automatically
every time you exit DLaunch.

The Cheat Codes button will display a window showing some of DOOM's "cheat" key 
commands that, if typed during a game, will allow you to cheat your way through.  Try not
to use them too much, it's no fun that way!

The Parameters button will display a window showing some of DOOM's command line 
parameters, which, if typed in at the DOS prompt following the DOOM command, will 
allow you to modify the way the game is played, watch demos, load saved games, etc.

The Episode... button will launch the Episode Builder, where you can select your favorite 
PWAD files, position them in the order you like, then Build an episode containing those 
PWADs that, when loaded, will allow you to play each of them in order just like a regular 
DOOM episode!  Full docs on the Episode Builder appear later in the section entitled 
"The Episode Builder".

The Help button will display a message directing you to this file for complete 
documentation.



A new button, added in Version 2.0a, is called the Skank Button, and is depicted as a little
toxic waste barrel.  When clicked, the barrel catches on fire, and the resultant procedure 
deletes all currently selected WAD files (except for DOOM.WAD), and associated files 
with the same name.  It's a great feature for those PWAD files that shouldn't have been 
uploaded to your favorite BBS in the first place!  It asks for confirmation first.

The Episode Builder

The Episode Builder is accessed by pressing the Episode... button on the main DLaunch 
form.  The Episode Builder allows you to select your favorite PWAD files, position them in
a list in the order you prefer, then Build an episode that when loaded from the main 
DLaunch form will play each of the PWADs in order, just like a regular DOOM episode!

The Episode Builder form is shown below:

As you can see, the Episode Builder contains the standard Drive and Directory list boxes 
to allow you to find your favorite PWADs anywhere on your system or network.  The WAD
Files list box in the upper left contains the WAD files on the drive and directory currently 
selected.

The list box in the upper right of the screen shows those PWAD files that have been 
selected for inclusion in the new episode, and in the order that they will be patched to 
play.  The file at the top of the list will become Episode 1, Map 1, the second file will be 
Episode 2, Map 2, etc.  You may place up to 27 files in the episode list box, but be aware 
that because DOS is limited in its command line length, you may not be able to play an 
episode which contains that many files.



Pressing the >, >>, <, and << buttons allows you to move single, multiple, or all files back
and forth between the list boxes at the top.  The >> and << buttons will move all listed 
files to or from the episode list box, and the > and < buttons will move all files currently 
selected into the episode list box, or the currently selected file out of the episode list box.

The Up and Dn buttons are used to move the PWAD files up or down in the order in the 
episode list box.  In this manner, you can choose which PWAD files you wish to play first, 
second, etc.

There are two methods for creating an episode, basically copying the PWAD files and 
patching the copies to play at specific levels, or more dangerously, patching the original 
PWAD files in place.  DLaunch does not patch original PWAD files, as some PWAD files 
may not appreciate being patched, and as a result the Patch WADs option in the Mode 
box will never be enabled.  Further development may make this method viable.

Episode Builder will create a file called DLAUNCH.EPI consisting of the basic episode 
information, then it will copy each of the PWAD files you have selected to the path you 
have selected in the Episode Path text box to files named A-Z and 0.WAD, meaning that 
Episode 1, Map 1 will be stored in A.WAD, Episode 1, Map 2 will be stored in B.WAD, 
etc., up to the maximum of 27 files, the last of which is stored in 0.WAD (Zero, not Oh).

NOTE:  MAKE SURE YOU DON'T HAVE ANY FAVORITE PWAD FILES NAMED A.WAD,
B.WAD...0.WAD, etc., AS EPISODE BUILDER MAY COMPLAIN.  I'd hate to see them 
get overwritten for some reason, too.

The reason for copying the files is -safety- so that we aren't patching into your favorite 
PWAD files, and the reason for the short filenames is that DOS is very limited in its ability 
to accept a long command line, so we want to keep the file names as short as possible.  
Even when this short, it is only possible to fit 18 or so into any given episode and still 
have room for your other favorite options, like -ReSpawn, -DevParm, etc.

NOTE:  YOU'LL BE ABLE TO FIT MORE FILES INTO AN EPISODE BY KEEPING THE 
EPISODE FILES A.WAD, B.WAD...0.WAD, etc. IN YOUR MAIN DOOM DIRECTORY.  
DLaunch is smart enough to not put the absolute path to each .WAD file into the 
command line if it's already in that directory, and you'll be able to play 18 or more levels, 
instead of just 5 or 6.

To play the episode, return to the main DLaunch screen, select Episode Files (*.EPI) as 
the File Type, instead of *.WAD, then select the file DLAUNCH.EPI you created and 
press the DOOM button!

The Delete button will remove the DLAUNCH.EPI file, and any file named A-Z and 
0.WAD from the directory specified in the Episode Path text box.



What could go wrong?

I've tested DLaunch quite extensively on my machine and network, which are a Compaq DeskPro
XE 560 and an IBM Token Ring network respectively.  Everything works OK for me, but other 
users have experienced a few small problems.  Any suggestions you have on these issues would 
be greatly appreciated.  (Don't you wish more software packages told you what to expect?)

1.  DLaunch may load and play the normal DOOM.WAD file even though you have 
selected a WAD file in the File selection list box.  This may be related to the amount of 
free memory you have available, and has been solved by several users with a simple 
reboot, and by other users through clearing TSR's or by using DOS's multi-boot option to 
clear up more memory.  Try the recommended PIF settings listed above, too.

2.  When you try to start DLaunch, you may get the error message "Path not found".  This
means that the DLaunch.INI file contains an invalid path.  Open the DLaunch.INI in your 
favorite text editor, and look for the line which reads Path=blahblahblah (where 
blahblahblah is possibly a bad path).  Replace the blahblahblah part with something valid 
like "C:\" (without the double-quotes), then start up DLaunch and everything should be 
OK.

3.  We have been unable to test the network multiplayer portion of the game, as our 
network is not IPX compatible, and all of the nifty patches on CompuServe don't seem to 
help.  We do get the game to work for a few moments, then everything hangs up 
requiring a power-off.  Some reports blame this on the new version of DOOM (1.2).

4.  You may get a message stating "Unable to find VBRUN300.DLL".  You must acquire 
and copy the file VBRUN300.DLL into your \Windows\System directory.  This file is 
available on CompuServe, or with Visual Basic 3.0 from Microsoft.

5.  DOOM 1.2 on my machine only plays demos if they are in the main DOOM directory, 
and if you leave off the .LMP extension.  I assume this is a "feature" and not a bug, so I 
have chosen to accomodate it in this release of DLaunch.

6.  DOOM 1.2 really screws up badly when I try to load a saved game on my machine 
from the command line, and therefore also from DLaunch.  If you have no troubles from 
the command line I assume you'll have none from DLaunch either.

What has changed?

Since Version 1.0, several things have changed:

Version 1.0a:

Version 1.0a saw the addition of a Save Settings button to allow the user to save his/her 
settings immediately, and the addition of the COM3 and COM4 options I had overlooked 
in Version 1.0.



Version 1.0b:

Version 1.0b allowed the user to specify which executables would be called for all 3 game
styles with manual or dialog entry (phew).  This lets the user specify an EXE, BAT, PIF, or
other executable program which is much less limiting.

The layout of the screen was modified, and controls were made visible or invisible 
whenever appropriate.

A menu option was added to Launch DOOM.

A Help button and Defaults button were added.

I actually made the COM3 and COM4 options I added in Version 1.0a WORK.  They 
weren't saved and read from the .INI file very well.

Version 1.1:

Version 1.1 included the AutoWarp function to automatically warp to the correct Episode 
and Map of your selected PWAD file.

The Warp function was modified to only be available when DevParm is selected, which is 
the only time it will work, anyway.

Version 1.2:

Version 1.2 was modified to include the Cheat Codes and Parameter buttons to display 
some of my favorite ways to modify DOOM's actions.  These actions also appear on the 
Help menu.

The WAD list box now allows you to select multiple PWADs!  You can select several 
PWAD files to be loaded all at the same time!  AutoWarp will jump automatically to the 
last PWAD selected.

Version 2.0:

Version 2.0 was modified to include the Episode Builder, a function which allows you to 
select your favorite PWAD files and build them into an episode which plays just like a 
regular DOOM episode!

A bug which affected your ability to play PWAD files outside of the DOOM directory was 
fixed.

Version 2.0a:

Version 2.0a was modified to include what I call the Skank Button (a little picture of a 
toxic waste barrel).  This button deletes a WAD file and all associated files of the same 
name.  When you find a PWAD file that really stinks, use this button, or the File\Skank 
menu option.

Version 2.1:

Version 2.1 includes the options for the DOOM Shareware 1.6 version for Alternate 
Deathmatch Rules (DeathMatch 2.0), and the FAST monster button to speed the 
monsters to "Nightmare!" mode.



Disclaimer

The DLaunch utility is provided AS IS.  The author will in no way be responsible, in financial or 
any other terms, for damages (both consequential and incidental) resulting from the use or 
misuse of DLaunch.

Shareware Vendor Distribution Agreement and Information

Effective June 16, 1994

Limited License To Copy The Software

You are granted a limited license to copy DLaunch only for the trial use of others 
subject to the terms of the software license agreement supplied with this 
program, and the conditions described below:

DLaunch must be copied in an unmodified form and DLaunch.ZIP must contain
the following files:
    
DLAUNCH.EXE The Windows executable program.
DLAUNCH.WRI The program documentation.
REGISTER.WRI The shareware registration form.

Vendor's Permissions

Public domain disk vendors may not charge a fee for DLaunch itself. However you may 
include DLaunch on a diskette or other media for which you charge a nominal distribution
fee as long as the conditions below are met.
    

1. Notify purchaser of media prior to accepting payment that the fee paid to 
acquire the media does not relieve the purchaser from their obgliation to register 
DLaunch should they find the program useful.
    
2. The above statement should be directly attached to the media being sold.


